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Versions de l'appareil
Version
du
produit

Manuel de mise en
service

Modifications Commentaires

2.09.xx BA00065S/04/FR/
01.12

– Manuel de mise en service

2.09.xx BA00065S/04/FR/
02.13

Nouveau WirelessHART, carte NI, modem FFusb ; modem
Bluetooth MACTek, installation DTM, mise à jour
du catalogue DTM, remplacement iDTM

Éditorial Procédure d'installation USB sous Windows 7

Disposition Nouveau CD

2.10.xx BA00065S/04/FR/
03.15

Disposition Nouveau CMS

Nouveau Section HART via Rockwell Automation
ControlLogix, PROFIBUS PA via Rockwell
Automation ControlLogix, rôles utilisateur,
vérification du réseau

2.10.xx BA00065S/04/FR/
04.15

Nouvelles sections et
modifications

HART via RSG45, Fieldgate SFG500 et Siemens
ET200M/iSP, PROFIBUS DP via modem PROFIBUS
et WAGO Remote I/O, PROFIBUS DP via
PROCENTEC ProfiCore, vue Installation,
informations sur les erreurs SFG500

2.11.xx BA00065S/04/FR/
05.16

Nouvelles sections et
modifications

Introduction à FieldCare, Pepperl+Fuchs LB/FB
Remote I/O, HIMA, PROFINET – passerelle
PROFIBUS, PBI-PLUS, Heartbeat Verification,
réseaux I/O Link, interface avec W@M

2.11.xx BA00065S/04/FR/
06.17

Documentation
séparée dans le
manuel de mise en
service et
documentation
spéciale

Tutoriel pour les projets FieldCare SD01928S

2.12.xx BA00065S/04/FR/
07.17

Nouvelle version de
produit
Changements
concernant la section
"Configuration"

-

2.13.xx BA00065S/04/FR/
08.18

Nouvelle version de
produit

-

2.13.xx BA00065S/04/FR/
09.18

Modifications Rubrique I/O-Link supprimée

2.14.xx BA00065S/04/FR/
10.19

Nouvelle version de
produit

IO-Link

2.15.xx BA00065S/04/FR/
11.20

Nouvelle version de
produit

• Clé USB au lieu d'un DVD
• Gestion des licences logicielles (SLM)

2.17.xx BA00065S/04/FR/
12.22

Nouvelle version de
produit

• Prise en charge des packs FDI
• Mise à jour de sécurité
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Version
du
produit

Manuel de mise en
service

Modifications Commentaires

2.18.xx BA00065S/04/FR/
13.23

Nouvelle version de
produit

• Prise en charge de Windows 11
• Microsoft SQL Server 2022 Express
• Mise à jour de la prise en charge des packs FDI,

Endress+Hauser et fabricants tiers
• PROFINET CommDTM mis à jour
• CDI CommDTM mis à jour
• DTM de vérification Flow mis à jour
• Mise à jour de sécurité des composants
• Manuel de sécurité SD03193S
• Mise à jour du catalogue, analyse B&R et IO-

Link améliorée
• Fonctionnalité W@M supprimée étant donné

que le portail W@M a été arrêté le 31.12.2023

2.19.xx BA00065S/04/FR/
14.24

Nouvelle version de
produit

• Driver de communication FXA291 mis à jour
• Softing PROFIdtm mis à jour
• DTM de vérification mis à jour
• PROFINET CommDTM mis à jour
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1  Informations relatives au document

1.1  Fonction du document
Le présent manuel fournit toutes les informations nécessaires à l'utilisation du logiciel : de
la description du produit, du montage et de l'utilisation aux mises à jour du logiciel et à la
mise au rebut en passant par l'intégration système, la configuration, le diagnostic et le
dépannage.

1.2  Symboles utilisés

1.2.1  Symboles d'avertissement
DANGER

Ce symbole attire l'attention sur une situation dangereuse entraînant la mort ou des
blessures graves si elle n'est pas évitée.

AVERTISSEMENT

Ce symbole attire l'attention sur une situation dangereuse pouvant entraîner la mort ou
des blessures graves si elle n'est pas évitée.

ATTENTION

Ce symbole attire l'attention sur une situation dangereuse pouvant entraîner des blessures
de gravité légère ou moyenne si elle n'est pas évitée.

AVIS

Ce symbole identifie des informations relatives à des procédures et d'autres situations
n'entraînant pas de blessures.

1.2.2  Symboles pour certains types d'information

Symbole Signification

Autorisé
Procédures, processus ou actions qui sont autorisés.

Préféré
Procédures, processus ou actions préférés.

Interdit
Procédures, processus ou actions qui sont interdits.

Conseil
Indique des informations complémentaires.

Renvoi à la documentation

A Renvoi à la page

Renvoi au graphique

Remarque ou étape individuelle à respecter

1. , 2. , 3.… Série d'étapes

Résultat d'une étape

Aide en cas de problème

Contrôle visuel
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1.2.3  Symboles FieldCare

Symbole Signification

Démarrer un nouveau projet.

Ouvrir un projet existant.

Enregistrer un projet ouvert.

Imprimer un projet ouvert.

Ouvrir le Presse-papiers.

Afficher le catalogue DTM.

Ouvrir la documentation pour l'appareil sélectionné ou les informations détaillées sur l'appareil.

Ouvrir l'inventaire.

Activer le protocole.

Ajouter un nouvel appareil au réseau.

Supprimer l'appareil du réseau.

Créer une nouvelle topologie de réseau à l'aide de CommDTM et de DeviceDTM.

Compare la topologie du réseau sur le terrain avec le réseau physique réel, et les appareils sont
ajoutés au réseau existant.

Analyse la topologie préconfigurée et affiche le rapport avec les informations de l'appareil analysé.

Indique l'existence d'une connexion avec l'appareil.

Transférer les informations à partir de l'appareil vers FieldCare.

Transférer les informations à partir de FieldCare vers l'appareil.

Fonctions spécifiques à l'appareil sélectionné.

Ajouter un niveau d'installation.

Ajouter un élément.

Supprimer un niveau d'installation.

Supprimer un élément.

Ouvrir la liste de contrôle d'appareil afin d'afficher les appareils sélectionnés dans l'installation.

Confirmer l'appareil remplacé.

Déconnecté.  1)
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Symbole Signification

Configurer la communication, prêt pour la communication  1)

Canal de communication occupé ou action de communication annulée. 1)

Connecté  1)

Activer le mode tactile

Désactiver le mode tactile

1) Indicateur d'état : indication d'état en ligne/hors ligne des appareils dans la vue Installation et Réseau

1.3  Mise en évidence du texte

Mise en évidence Signification Exemple

Gras Touches, boutons, icônes programme,
onglets, menus, commandes

Start → Programs → Endress+Hauser
Dans le menu File, sélectionner l'option Print.

1.4  Acronymes utilisés

Acronymes Signification

APL Advanced Physical Layer (Couche physique avancée)

CSV Comma Separated Value (Valeurs séparées par des virgules)

DTM Device Type Manager (drivers pour les appareils)

FDI Field Device Integration (Intégration des appareils de terrain)

FDT Field Device Tool

HART Highway Addressable Remote Transducer

I/O Entrée/sortie

IO-Link Nom de marque d'un système de communication comprenant des capteurs et des actionneurs
intelligents

IODD IO Device Description (Description d'appareils électroniques)

IP Internet Protocol (Protocole Internet)

PROFIBUS Process Field Bus

PROFINET Process Field Network

SLM Software License Management (Gestion des licences logicielles)

TCP Transmission Control Protocol (Protocole TCP)

UDP User Datagram Protocol (Protocole UDP)

URL Uniform Resource Locator

1.5  Documentation
FieldCare SFE500
• Guide de démarrage KA01303S
• Tutoriel pour les projets FieldCare SD01928S
• Information technique TI00028S
• Manuel de sécurité SD03193S
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1.6  Marques déposées
PROFINET® est une marque déposée par l'Organisation des Utilisateurs Profibus (PNO),
Karlsruhe/Allemagne.

PROFIBUS® est une marque déposée par l'Organisation des Utilisateurs Profibus (PNO),
Karlsruhe/Allemagne.

IO-Link® est une marque déposée de l'IO-Link Community c/o PROFIBUS User
Organization, (PNO) Karlsruhe/Allemagne

FOUNDATIONTM Fieldbus est une marque déposée du FieldComm Group, Austin, TX
78759, USA.

HART®, WirelessHART® est une marque déposée du FieldComm Group, Austin, TX 78759,
USA.

Ethernet/IP est la marque déposée de l'ODVA, Michigan USA.

Modbus® est une marque déposée par l'organisation Modbus, Hopkinton, USA

Toutes les autres marques et tous les autres noms de produit sont des marques déposées
des sociétés ou organisations concernées.
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2  Consignes de sécurité de base

2.1  Exigences imposées au personnel
L'accès physique et électronique aux appareils, réseaux, ordinateurs et systèmes de terrain
doit être limité à un groupe autorisé de personnes. Par conséquent, un système d'accès
basé sur les rôles doit être utilisé. Établir des directives et procédures détaillées afin de ne
permettre l'accès au PC ou autre équipement qu'à des personnes autorisées.

2.2  Utilisation conforme
FieldCare est un outil de gestion des équipements basé sur FDT (Field Device Tool) qui, en
fonction de la version, peut être utilisé pour la configuration des paramètres d'appareil, la
gestion des appareils ou la surveillance d'état. Grâce à l'utilisation des pilotes Device Type
Manager (DTM) appropriés, il est en mesure de faire fonctionner les appareils de terrain et
les composants du système indépendamment du protocole de communication.

Un pare-feu correctement configuré doit être utilisé, celui-ci devant bloquer toutes les
données qui ne répondent pas aux spécifications de sécurité. Pour accroître davantage la
sécurité, les ports qui ne sont pas utilisés doivent être désactivés et un système de
détection de zone démilitarisée ou d'intrusion doit être utilisé. Une gestion des patches en
temps réel doit être mise en place pour tous les produits, comme les systèmes
d'exploitation, les navigateurs Internet, les programmes, les apps, les bases de données et
les pilotes. De même, un logiciel antivirus doit être utilisé sur le PC. Les matériels, les
logiciels, les firmware et tout autre contenu électronique ne devraient être utilisés que s'ils
proviennent de sources fiables.

Il est recommandé d'utiliser des mots de passe sûrs pour l'accès électronique aux
programmes, p. ex. pour le PC, FieldCare, SQL Server et les appareils de terrain :
• Le mot de passe doit comporter au moins 8 caractères
• Ne pas utiliser de nom d'utilisateur, de nom ou de nom d'entreprise
• Il ne doit pas contenir un mot complet
• Il doit être très différent des mots de passe précédents
• Il doit être composé de lettres majuscules, de lettres minuscules, d'un chiffre et d'un

symbole
• Il doit être changé régulièrement

Pour les consignes de sécurité détaillées, voir le manuel de sécurité SD03193S
(www.endress.com/SFE500)

2.3  Sécurité du produit
DEP – Prévention d’exécution des données
La prévention d’exécution des données (DEP – "Data Execution Prevention") est un outil de
sécurité qui aide à prévenir des virus, des dommages et des menaces de sécurité de votre
ordinateur. En surveillant les programmes, la prévention d’exécution des données peut
aider à protéger l'ordinateur et s'assurer que les applications utilisent la mémoire système
en toute sécurité. Dès qu'une application tente d'accéder à un programme, la prévention
d’exécution des données ferme le programme.

Configuration de la prévention d’exécution des données
1. Cliquer sur la touche Windows → touche Pause → Paramètres système avancés →

Avancés.

2. Entrer le mot de passe administrateur à l'invite.

3. Sélectionner Performance → Paramètres.
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4. Cliquer sur l'onglet Prévention de l’exécution des données et sélectionner Activer
la prévention d’exécution des données pour tous les programmes et les services.
Si le programme n'est pas dans la liste, cliquer sur Ajouter, sélectionner le
programme et cliquer sur Ouvrir.

5. Cliquer sur OK.
 La boîte de dialogue "Propriétés du système" s'ouvre.

6. Cliquer sur OK.

7. Redémarrer l'ordinateur pour activer les changements.

Numéro Explication État

0 Toujours Off La prévention de l’exécution des données est désactivée pour tous les processus.

1 Toujours On La prévention de l’exécution des données est activée pour tous les processus.

2 Opt In La prévention de l’exécution des données est activée par défaut pour les principaux
programmes et services Windows.

3 Opt Out La prévention de l’exécution des données est possible pour tous les processus, à
l'exception des programmes et des services.

Améliorations techniques
Endress+Hauser se réserve le droit d'apporter des améliorations techniques aux logiciels et
aux appareils, à tout moment et sans préavis. Si de telles améliorations n'ont aucun effet
sur le fonctionnement du logiciel, elles ne sont pas documentées. Si les améliorations ont
une incidence sur le fonctionnement, une nouvelle version du manuel de mise en service
est créée et publiée.

2.4  Sécurité informatique
Notre garantie n'est valable que si le produit est installé et utilisé comme décrit dans le
manuel de mise en service. Le produit dispose de mécanismes de sécurité pour le protéger
comtre toute modification involontaire des réglages.

Des mesures de sécurité informatique, qui assurent une protection supplémentaire du
produit et de la transmission de données associée, doivent être mises en place par les
opérateurs eux-mêmes conformément à leurs normes de sécurité.



Description du produit FieldCare SFE500

12 Endress+Hauser

3  Description du produit

3.1  Fonction du logiciel
Le présent manuel de mise en service décrit la manière dont FieldCare peut être utilisé
pour établir une connexion avec des appareils HART, PROFIBUS, FOUNDATION Fieldbus,
Modbus, IO-Link et EtherNet/IP à l'aide de modems, passerelles et d'E/S distantes (Remote
I/O).

3.1.1  Gestion des licences logicielles (SLM)
Informations détaillées sur la "Gestion des licences logicielles (SLM)" : Guide de
démarrage →   8

3.1.2  Rôles utilisateur
La connexion de l'utilisateur est initialement désactivée après l'installation de
FieldCare, si bien que FieldCare peut être démarré sans avoir à se connecter.

Activation de la connexion de l'utilisateur
1. Ouvrir FieldCare Administrator →   16.

2.

User and User Groups → Configuration doit être sélectionné et User Login active
activé.

Rôles utilisateur
Différents rôles utilisateur sont disponibles. Chaque utilisateur peut se connecter avec un
rôle spécifique qui lui a été affecté. L'utilisateur reçoit l'autorisation pour certaines
fonctions. Ainsi, seuls les utilisateurs autorisés ont accès aux fonctions techniques et
d'exploitation. En outre, les droits peuvent être définis pour une période déterminée.

• Créer un nombre illimité d'utilisateurs
• Assigner des paramètres optionnels au compte utilisateur
• Modifier le mot de passe selon les paramètres optionnels
• Les utilisateurs peuvent changer un mot de passe
• Le mot de passe de l'utilisateur est valide pour une période spécifiée
• Désactiver le compte utilisateur si nécessaire
• Assigner à l'utilisateur un rôle conformément à la norme FDT

Rôle utilisateur Autorisation

Administrateur Accès illimité à toutes les fonctions, p. ex. phases de développement, de mise en
service et d'exécution dans FieldCare.

Tâches administratives, p. ex. allouer des comptes utilisateur.

Changer ou mettre à jour le catalogue DTM.

Ingénieur de planification Accès illimité à toutes les fonctions, p. ex. phases de développement, de mise en
service et d'exécution dans FieldCare.

Ingénieur de maintenance Exécution des phases de mise en service et d'exploitation autorisées.

Remplacer, étalonner et ajuster les appareils.

Écrire les paramètres dans les appareils, modifier ou lire des paramètres.
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Rôle utilisateur Autorisation

Exécution d'opérations spécifiques aux appareils en mode en ligne.

Utilisateur Exécution des phases de mise en service et d'exploitation autorisées.

Observer et gérer le processus en cours.

Contrôler l'état actuel d'un appareil.

Modifier les points de consigne afin de garantir le bon fonctionnement de l'appareil.

Observateur Observer et gérer le processus en cours.

Lire les paramètres de l'appareil et documenter les appareils connectés.

3.2  Domaine d'application
FieldCare est l'outil universel destiné à la configuration et à la gestion d'appareils de terrain
intelligents. Configuration simple des appareils ; la gestion de la maintenance, la
maintenance conditionnelle et la gestion des équipements (asset management) sont
également possibles. Il peut être adapté à différents besoins selon la licence, et peut, par
conséquent, être mis à niveau à tout moment.
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4  Montage
Informations détaillées sur l'"Installation" : Guide de démarrage →   8
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5  Configuration

5.1  Démarrage de FieldCare
‣

Ouvrir FieldCare.
 FieldCare est ouvert.

5.2  Réglages dans FieldCare
1. Démarrer FieldCare→   15.

2. Fermer la boîte de dialogue "FieldCare".
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3. Cliquer sur Extras → Options.
 La boîte de dialogue "Options" s'ouvre.

4. Effectuer les réglages nécessaires, p. ex. la langue.

5. Enregistrer les changements avec OK.

5.3  Réglages dans FieldCare Administration
Fermer FieldCare avant de démarrer FieldCare Administration.
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1.

Ouvrir FieldCare Administration.
 La boîte de dialogue "FieldCare Administrator Login" s'ouvre.

2. Entrer le nom d'utilisateur Administrator et le mot de passe Admin, puis cliquer sur
Login.
 La boîte de dialogue "FieldCare admin" s'ouvre.

3. Sélectionner le menu souhaité dans la colonne de gauche de la fenêtre, par exemple
Users.

4. Ouvrir le menu contextuel et effectuer les réglages requis.

5. Enregistrer les changements.
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5.4  Interface utilisateur

 1 Boîte de dialogue principale de FieldCare

1 Vue Installation
2 Vue réseau
3 Barre de menus
4 Barre d'outils
5 Vue DTM/paramètres
6 Boîtes de dialogue optionnelles
7 Barre d'état

5.5  Réglages généraux

5.5.1  Paramètres du projet
1. Dans FieldCare, cliquer sur Extras → Options.

2. Cliquer sur l'onglet Project.
 L'onglet "Project" s'affiche.

3. Sélectionner Prompt for project at start-up et cliquer sur OK.
 La boîte de dialogue Project est affichée à chaque fois que le programme est

démarré.
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5.5.2  Paramètres de scrutation ("scanning")
1. Dans FieldCare, cliquer sur Extras → Options.

2. Cliquer sur l'onglet Scanning.
 L'onglet "Scanning" s'affiche.

3. Sélectionner la case à cocher devant Connect after scanning if only one device is
found and automatically open the DTM in the Online window, puis cliquer sur OK.

Une fois le réseau configuré, le résultat de l'analyse s'affiche.

Après la scrutation, si FieldCare ne trouve qu'un seul appareil, une connexion
automatique est établie avec le DTM et il est commuté en ligne. Si plusieurs appareils
ont été trouvés, chaque DTM doit être connecté séparément. En fonction du DTM, un
double-clic sur un appareil non connecté déclenche également la connexion. Si ce n'est
pas le cas, l'option Connect doit être utilisée. La configuration d'appareils individuels
n'est pas décrite dans le présent manuel de mise en service. Ces informations peuvent
être trouvées dans le manuel de mise en service relatif à l'appareil concerné.

Par défaut, FieldCare utilise les interfaces FDT 1.2 pour effectuer une scrutation. Si
l'option "Prefer FDT 1.2.1 scan" est activée, les options de scrutation FDT 1.2.1 peuvent
être utilisées comme alternative.

FDT 1.2.1 peut offrir des avantages en termes de vitesse lors de la scrutation avec les
propres DTM de communication/passerelle.

5.5.3  Vue Installation
Les modifications apportées à la vue Réseau sont automatiquement synchronisées
avec la vue Installation. Les modifications manuelles apportées à la vue Installation
n'affectent pas la vue Réseau. Il est ainsi possible de concevoir une installation
indépendamment de la topologie du réseau.

Ajout d'un nouveau niveau
1. Cliquer avec le bouton droit sur un élément.

2. Cliquer sur Plant View → Add Plant Level.
 Un nouveau niveau d'installation peut être sélectionné.



Configuration FieldCare SFE500

20 Endress+Hauser

 2 Structure de la vue Installation

Niveau d'installation Description

Entreprise Ne créer qu'une seule entrée de ce type dans le niveau supérieur 0.

Système
Portée
Cellule de process
Unité

Créer au niveau 1.

Portée
Cellule de process
Unité

Créer sous le type "Site".

Cellule de process
Unité

Créer sous le type "Zone".

Unité Créer sous le type "Cellule de process".

Appareil d'analyse
Appareil numérique
Transmetteur de pression
Spécial
Débitmètre
Transmetteur de niveau
Transmetteur de température
Vanne
Appareil inconnu

Créer sous le type "Unité".

Élément Modifier l'élément ultérieurement avec Change software.

 Ceci n'est plus possible rétrospectivement pour tous les autres types. Dans
ce cas, le type doit être supprimé et un nouveau type doit être créé.

 Une entrée peut être liée logiquement à un appareil dans la vue Réseau à l'aide de la fonction Assign.
Supprimer le lien à l'aide de Unassign Device.
Les textes de légende de toutes les entrées peuvent être modifiés ultérieurement.
Une note peut être saisie pour chaque entrée via le menu contextuel, ou chaque entrée peut être liée à un
fichier ou à l'URL d'un site Web.

La vue Réseau doit d'abord être créée avant que la vue Installation ne puisse être créée. La
vue Installation correspond à la topologie réelle de l'installation ; la vue technologique est
une représentation hiérarchique du process de production. Tout utilisateur ayant le rôle
d'"ingénieur de planification" ou un rôle supérieur peut créer de nouvelles vues Installation
ou modifier des vues existantes.
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Les éléments peuvent être déplacés dans la vue Installation. Les éléments de la vue
Installation peuvent être renommés, ajoutés ou supprimés.

Colonne Utilisation

TAG installation Repère pour chaque position de l'installation.

Connexions Symbole indiquant l'état en ligne/hors ligne.

État Indique l'état de diagnostic actuel.

Surveillé Option permettant d'activer la surveillance de l'appareil courant via l'application
Condition Monitoring.

Critique Option permettant de spécifier si l'appareil est un appareil critique.

Voie Indique la voie via laquelle l'appareil est connecté.

Adresse Indique l'adresse de l'appareil qui est assigné à cette position d'installation.

Type d'appareil (DTM) Indique le type de l'appareil.

Appareil physique Identifie l'appareil physique sur un point particulier du réseau.

5.5.4  Vue Réseau
La vue Réseau est une représentation graphique du réseau d'appareils appartenant à un
projet FieldCare.

Colonne Utilisation

TAG réseau Repère réseau de l'appareil.

Connexions Symbole indiquant l'état en ligne/hors ligne.

Voie Indique la voie via laquelle l'appareil est connecté.

Adresse Adresse réseau unique de l'appareil.

Type d'appareil (DTM) Indique le type de chacun des appareils individuels.

Appareil physique Identifie l'appareil physique sur un point particulier du réseau.

5.6  Fonctions générales
Vue Installation/Réseau
• Via le menu contextuel → Customize Plant View
• Boîte de dialogue d'affichage
• Afficher/masquer les colonnes
• Ajuster l'ordre des colonnes

Fonction liste
• Ajuster pour que les listes soient triées en fonction de l'en-tête de colonne
• Changer la largeur de colonne
• Changer l'ordre des colonnes à l'aide de "Copier" et "Coller"

5.7  Vérification du réseau
La topologie du réseau dans FieldCare peut être comparée par rapport au réseau physique
actuel. Ceci est particulièrement utile si un appareil est ajouté à un réseau existant. Un
projet peut être préparé hors ligne, puis téléchargé via FieldCare. De cette façon, il est
possible de vérifier la topologie actuelle du réseau et la topologie physique pour y apporter
les modifications nécessaires.

Avant de procéder à la vérification du réseau, il est à noter que seuls sont vérifiés les
réseaux pour les appareils de communication possédant au moins un DTM. Dans le
cas contraire, l'option de menu Verify Network est désactivée.
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Vérification du réseau
1. Dans la vue Réseau, sélectionner un appareil avec au moins un DTM.

2. Cliquer sur Verify network  dans la barre d'outils.
 La boîte de dialogue "Communication channel" s'ouvre.

3. Sélectionner la voie désirée et cliquer sur OK.
 FieldCare analyse la voie souhaitée.

Lorsque le réseau a été vérifié, la boîte de dialogue "Scanning Result" s'ouvre.
Une liste des appareils joignables est affichée dans la colonne Status, indiquant
dans quelle mesure les appareils de la topologie planifiée s'intègrent dans la
topologie réelle.
Il existe cinq états différents au total :
Les types d'appareil et les numéros de série sont identiques.
Les types d'appareil sont identiques.
Les types d'appareil sont différents.
Un nouvel appareil a été trouvé.
Appareil inattendu dans le projet.

4. Des modifications peuvent être effectuées dans le menu contextuel de l'appareil
concerné. Lire/écrire les données d'appareil ou remplacer le type d'appareil.
Cliquer sur OK pour confirmer les modifications.
 Les modifications sont enregistrées.
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6  Intégration système

6.1  Réglage d'une adresse IP
• Les droits d'administrateur sont requis
• La description s'applique à Windows 7

Tous les appareils Endress+Hauser pourvus d'une interface Ethernet sont livrés avec une
adresse IP par défaut, p. ex. l'adresse IP pour la Fieldgate FXA720 est 192.168.253.1. Pour
que l'ordinateur hôte puisse communiquer avec le serveur Web de la Fieldgate FXA720, il
doit se voir attribuer une adresse IP dans le même domaine d'adresses, p. ex.
192.168.253.99. Pour plus d'informations, contacter l'administrateur réseau.

Réglage de l'adresse IP de l'ordinateur
1. Cliquer sur Démarrer → Panneau de configuration → Réseau et Internet → Centre

Réseau et partage.
 La boîte de dialogue "Connexions réseau" s'ouvre.

2. Cliquer sur Gérer les connexions réseau.

3. Cliquer avec le bouton droit sur les connexions devant être modifiées.

4. Si nécessaire :
Entrer le (mot de passe administrateur ou la confirmation).

5. Cliquer avec le bouton droit sur l'onglet Réseau.

6. Cliquer sur Protocole Internet version 4 (TCP/IPv4) dans l'entrée "Cette connexion
utilise les éléments suivants".

7. Cliquer sur Propriétés.

8. Noter les valeurs d'origine de l'adresse IP et du masque de sous-réseau de l'ordinateur
pour les restaurer si nécessaire à la fin de l'opération. Un ordinateur utilisé dans un
réseau d'entreprise obtiendra automatiquement son adresse.
Cliquer sur Utiliser les adresses IP suivantes.

9. Entrer l'adresse IP, le masque de sous-réseau et la passerelle par défaut pour
"TCP/IPv4".
 Les réglages pour l'adresse IP sont acceptés.

10. Cliquer sur OK.
 La procédure est terminée.

6.2  Pare-feu Windows
Si des pare-feu sont utilisés sur les ordinateurs sur lesquels résident les serveurs et les
clients, ils doivent être programmés pour permettre un accès mutuel. Comme la
configuration du pare-feu est souvent une question de stratégie de sécurité
informatique de l'entreprise, il faut consulter l'administrateur système avant de
procéder. De plus, des droits d'administration sont requis pour effectuer cette tâche.

Les ports disponibles pour la Fieldgate SFG500 sont listés dans le tableau ci-dessous :

Numéro de port ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Gestion du pare-feu Windows
1. Appuyer sur Démarrer → Panneau de configuration → Pare-feu Windows.

2. Dans le volet de gauche, cliquer sur Autoriser un programme via le pare-feu
Windows.

3. Si nécessaire :
Entrer le mot de passe administrateur.

4. Cocher la case à côté du programme devant être autorisé, puis cliquer sur OK.

5. Dans le volet de gauche, cliquer sur Paramètres avancés.

6. Si nécessaire :
Entrer le mot de passe administrateur.

7. Dans la boîte de dialogue "Pare-feu Windows avec sécurité avancée", cliquer sur
Règles de trafic entrant.

8. Dans le volet de gauche, cliquer sur Nouvelle règle.

9. Suivre les instructions dans l'Assistant Nouvelle règle de trafic entrant.

10. Aller à l'onglet Exceptions.
 Deux niveaux principaux s'ouvrent. Les exceptions peuvent être ajoutées sur ces

niveaux.
"Ajouter un programme" spécifie les applications qui sont capables de répondre à
des requêtes non sollicitées.
"Ajouter un port" spécifie que le pare-feu doit autoriser le trafic TCP sur les ports
utilisés par les serveurs.

11. Sur l'onglet "Général", cocher la case Activé (recommandé).

Le pare-feu est à présent actif.
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7  Configuration
Les données relatives au projet sont enregistrées dans une base de données ou dans des
fichiers, selon le mode de stockage du projet.

7.1  Réglage de la langue d'interface
1. Ouvrir FieldCare.

2. Extras → Options doit être sélectionné.
 La boîte de dialogue "Options" s'ouvre.

3. Sélectionner la langue dans l'onglet Display, puis cliquer sur OK.
 La langue est enregistrée et disponible la prochaine fois que le programme est

démarré.

7.2  Création d'un projet
Les premières étapes de la création d'un projet sont toujours identiques. Par défaut, la
boîte de dialogue FieldCare est affichée ; celle-ci peut être désactivée sous Extras →
Options → Project. Si la case à cocher None est activée, la boîte de dialogue FieldCare
n'est pas affichée.
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Création d'un projet
1. Ouvrir FieldCare.

 La boîte de dialogue "FieldCare" s'ouvre.

2. Dans l'onglet "New", sélectionner l'entrée Create Project, puis cliquer sur Open.
 FieldCare ouvre un nouveau projet avec un PC hôte.

7.3  Enregistrement d'un projet
Les projets FieldCare sont stockés dans une base de données mais ne sont pas
accessibles sous forme de fichiers sur le disque dur. Il est possible d'accéder à ces
fichiers en utilisant FieldCare en mode fichier. Tous les projets sont enregistrés de la
même manière.
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Enregistrement d'un projet
1. File → Save As doit être sélectionné.

 La boîte de dialogue Save Project As s'ouvre.

2. Entrer le nom du projet, puis cliquer sur Save.
 Le projet est enregistré.

7.4  Ouverture d'un projet enregistré
Ouverture d'un projet enregistré
1. Dans la boîte de dialogue FieldCare, cliquer sur l'onglet Existing.

 La boîte de dialogue "Open Project" est affichée avec les derniers projets ouverts.

2. Sélectionner le projet souhaité, puis cliquer sur Open.
 Le projet est affiché.

Si le projet n'apparaît pas à l'écran, cliquer sur View→ Network.

7.5  Exportation et importation CSV
Les informations structurelles de la vue Installation et de la vue Réseau (topologie de
l'installation/du réseau) peuvent être exportées vers un fichier CSV et importées depuis un
fichier CSV vers un projet FieldCare.



Configuration FieldCare SFE500

28 Endress+Hauser

Importation d'un fichier CSV
1. Créer un projet. →   25

2. Cliquer sur File → Import/Export → Import CSV file.
 La boîte de dialogue "Import CSV file" s'ouvre.

3. Sélectionner un fichier et cliquer sur Open.
 Les données du fichier CSV sont importées en vue Installation et/ou en vue

Réseau.

Exportation d'un fichier CSV
1. Sélectionner un projet.

2. Cliquer sur File → Import/Export → Export CSV file.
 La boîte de dialogue "Exported topology" s'ouvre.

3. Cliquer sur Export.

4. Sélectionner un emplacement de stockage et un nom, puis cliquer sur Save.
 La vue Réseau est exportée vers un fichier CSV.

7.6  Information DTM
La boîte de dialogue Information contient un résumé de toutes les informations DTM
pertinentes.

Affichage de l'information DTM
1. Cliquer sur Device Catalog dans la barre de menus.

2. Cliquer sur View.
 Le catalogue d'appareils s'ouvre.

3. Cliquer avec le bouton droit sur un DTM.

4. Cliquer sur DTM Information.
 La boîte de dialogue "Information" s'ouvre.

Options possibles dans la boîte de dialogue "Information"
• Affiche les informations de base de tous les types d'appareil pris en charge par le DTM
• Affiche l'information DTM :

• ID fabricant
• ID type d'appareil
• ID type d'appareil secondaire
• Information type appareil
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7.7  Affichage du catalogue d'appareils
La boîte de dialogue Device catalog contient la liste de tous les DTM et packs FDI qui se
trouvent actuellement dans le système de gestion des appareils. Les DTM peuvent être
groupés par catégorie, fabricant ou protocole.

1. Cliquer sur Device catalog dans la barre de menus.

2. Cliquer sur Display.
 Le catalogue d'appareils s'ouvre.

7.8  Mise à jour du catalogue d'appareils
Informations détaillées sur la Mise à jour du catalogue d'appareils : Guide de
démarrage →   8
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8  Diagnostic et résolution des problèmes

8.1  Résolution des problèmes généraux

Problème Solution

FieldCare SQL Server ne
démarre pas.

Démarrer SQL Server manuellement :
• Démarrer Windows et entrer services.msc dans le champ de recherche.
• Sélectionner SQL Server (SQLFIELDCARE).
• Cliquer sur Démarrer.

Macros d'analyse
manquantes.

Importer les macros :
• Dans le dossier "...\Endress+Hauser\FieldCare\db", importer le fichier

ImportScanningMacros.cmd.
• Ensuite, redémarrer FieldCare.

Entrées de menu en
double ou fenêtres
manquantes.

Réinitialiser la mise en page :
• Fermer FieldCare.
• Dans le dossier "...\Endress+Hauser\FieldCare\Profiles", supprimer le fichier

profile.xml.

Catalogue d'appareils
défectueux.

Réinitialiser le catalogue d'appareils FieldCare :
• Fermer FieldCare.
• Dans le dossier "...\Endress+Hauser\FieldCare\Frame", supprimer le fichier

FRMRepository.xml.
• Redémarrer FieldCare et mettre à jour le catalogue d'appareils.

En cas de problèmes additionnels, contacter Endress+Hauser :
www.addresses.endress.com
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9  Mises à jour du logiciel
Informations détaillées sur la "Mise à jour du logiciel" : Guide de démarrage →   8



www.addresses.endress.com

*71695127*
71695127
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